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About this document

Scope and purpose

The purpose of this document is to serve as an user guide for evaluating the new 160 V three phase gate driver
from Infineon Technologies - 6ED2742S01Q. EVAL-6ED2742S01QM1 for Battery Powered Applications (BPA)
evaluation kit consists of a three-phase inverter power board with the 160 V rated 6ED2742S01Q (in 5 x 5 QFN-32
package) three phase gate driver driving six 150 V rated OptiMOS™ MOSFETs BSC074N15NS5 (in 5 x 6 Super SO8
package). The power board has a M1 connector that is used to interface with iMotion™ Modular Application
Design Kit (MADK) control card - EVAL-M1-101T. This control card is powered by IMC101T-T038 iMOTION™ Motor
Control IC featuring advanced Motor Control Engine (MCE), that enables state-of-the-art Sensorless Field
Oriented Control (FOC) without need for any coding. IMC101T-T038 is a part of the iMOTION™ IMC100 series,
which is the next generation of well established iMOTION™ motor control IC platform dedicated to field-oriented
control of PMSM (BLDC) motors. The evaluation kit comes with both EVAL-6ED2742S01QM1 and EVAL-M1-101T
including a USB connector to interface with a laptop having MCE Designer software.

Intended audience

Direct Current (DC) based Motor (BLDC, Servo, Stepper) control system engineers designing battery operated
consumer power tools, outdoor power tools, robotics systems, drones, electric bikes and Small Home Appliances
such as hair dryers, vacuum cleaners.

Evaluation Board

This board is to be used during the design-in process for evaluating and measuring characteristic curves, and
for checking datasheet specifications. This board must be used in laboratory environment by trained power
electronic engineers adhering to safety requirements.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.

Note: Boards do not necessarily meet safety, EMI, quality standards (for example UL, CE) requirements.

Ordering information

Base part number Package Standard pack Orderable part number
Form Quantity

EVAL-6ED274201Q
BPA EVAL Kit MADK EVAL Boxed 1 EVAL6ED2742501Q
6ED2742501Q PG-VQFN-32 | Tape and Reel 3000 6ED2742S01QPXUMA1
EVAL-M1-101T MADK EVAL Boxed 1 EVALM1101TTOBO2
BSCO74N15NS5 PG-TSON-8 | Tape and Reel 5000 BSCO74N15NS5ATMAL
IFX25001 V33 PG-S0T223-4 | Tape and Reel 1000 IFX25001 ME V33
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Important notice

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).

Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards
has been tested by Infineon Technologies only as described in this document. The design is not qualified
in terms of safety requirements, manufacturing and operation over the entire operating temperature
range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products and are solely intended for
evaluation and testing purposes. They shall not be used for reliability testing or production. The
Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.

It is the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property.

The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.

Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions

Note: Please note the following warnings regarding the hazards associated with development systems

Table1l Safety precautions

Warning: The DC link potential of this board is up to 160 VDC. When measuring voltage
waveforms by oscilloscope, high voltage differential probes must be used. Failure to do
so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take
time to discharge after removal of the main supply. Before working on the drive
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to
do so may result in personal injury or death. Darkened display LEDs are not an
indication that capacitors have discharged to safe voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or
reconnect wires, or perform maintenance work. Wait five minutes after removing
power to discharge the bus capacitors. Do not attempt to service the drive until the bus
capacitors have discharged to zero. Failure to do so may result in personal injury or
death.

Caution: The heat sink and device surfaces of the evaluation or reference board may
become hot during testing. Hence, necessary precautions are required while handling
the board. Failure to comply may cause injury.

Caution: Only personnel familiar with the drive, power electronics and associated
machinery should plan, install, commission and subsequently service the system.
Failure to comply may result in personal injury and/or equipment damage.

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when
installing, testing, servicing or repairing the assembly. Component damage may result
if ESD control procedures are not followed. If you are not familiar with electrostatic
control procedures, refer to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage
or reduction in product lifetime. Wiring or application errors such as undersizing the
motor, supplying an incorrect or inadequate AC supply, or excessive ambient
temperatures may result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that
need to be removed prior to installation. Failure to remove all packing materials that
are unnecessary for system installation may result in overheating or abnormal
operating conditions.

>R BB
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1 The board at a glance

The evaluation board EVAL-6ED2742S01QM1 is powered by a DC source in the range of 10.8 V to 120 V and
provides a three-phase output to power upto 250 W (without heat sink) to 500 W (with heat sink) BLDC motors
operating at a nominal 24 V DC bus voltage. It contains the new 160 V, three phase gate driver IC 6ED2742S01Q,
the OptiMOS™ BSC074N15NS5, bus capacitors, a single shunt for current sensing, a voltage divider for DC-link
voltage measurement, and other peripheral circuits. The board can also be powered up from a 10.8 Vto 96 V Li-
ion battery pack. Before connecting the battery pack, ensure reverse polarity protection and inrush protection is
provided to EVAL-6ED2742S01QM1 board.

1.1 Scope of delivery

The EVAL-6ED2742501QM1 evaluation board is delivered along with an iMOTION™ 2.0 M1 interface connector
and EVAL-M1-101T control card.

The package also contains a DC-DC buck converter with integrated MOSFET to provide auxiliary power supply of
12 V and 3.3 V; a single shunt for current sensing and overcurrent protection; and a voltage divider for DC-link
voltage measurement. The board can be operated directly with the DC power supply without any additional
components. An inrush current limiter is recommended if operating directly from a battery source.

1.2 Block diagram

Figure 1 shows a typical application diagram of EVAL-6ED2742S01QM1 for driving a BLDC motor. The system
adopts a single-shunt configuration, which is prevalent for current BLDC motor drive applications.

=
VIN
GND 6ED2742501Q
4 VIN _ )
a1l J a3 J as J J-
HOA J A oo Jq A 03 DS
. HOB s Hoc w¥Sd——s ginc
Microcontroller Three Phase Gate Driver Q2 04 - MOTOR

ukst
N 4l
LOA ry D4 Loy
i‘k . J 1 Jr: T Ds
LOB Loc

Over Cur.rent ﬁ Rshunt
Protection
=

GND

Note: Board DC input at VIN, OUTPUT at BLDC MOTOR
Figure 1 Simplified application block diagram of EVAL-6ED2742S01QM1

The 6ED2742S01Q is a 160 V SOI based gate driver designed for three phase BLDC motor drive applications.
Integrated bootstrap diodes are used to supply the three external high sides charging bootstrap capacitors and
supports 100% duty cycle operation by a trickle charge pump. Protection features include under voltage lockout,
over current protection with configurable threshold, fault communication and automatic fault clear. The output
drivers feature a high-pulse current buffer stage designed for minimum driver cross-conduction. A current sense
operational amplifier (CSA) with selectable gain is integrated between the VSS and COM

User Guide 6 Revision 1.00
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The functional blocks of EVAL-6ED2742S01QM1 BPA Evaluation Kit are presented in Figure 2

MADK Board 6ED2742S01Q Eval Board

ERErOIERY EUAL-6ED27425010M! UFD 2 e

2021-09-02

N &

5. To 3 phase
2 motor
: Vlnﬂneon e :{‘p“%l‘; S ;”’%mh:m r L ; ¥ '1 1 _:30 ey 0 3115 L i DC Input:
oiaeiias, @@@@ Sl s ] 12 Vto 48 V
IMC101T
6ED2742501Q BSCO74N15NS5
Figure 2 Functional blocks of EVAL-6ED2742S01QM1 BPA Evaluation Kit (top view)

1.3 Main features

The main features of EVAL-6ED2742S01QM1 include:

e Nominal DCinput voltage of 24 V

e Design for maximum 250 W motor power output (500 W with added heatsink / forced air cooling)
o Single shunt for current sensing

e Sensing of DC-link voltage

e +12Vand +3.3Vauxiliary power supplies on the board

e M1l interface compatible with the iMOTION™ control board

e Integrated power management unit (PMU) inside 6ED2742501Q with

o Linear pre-regulator to enable wide input VIN range
o Integrated charge pump for stable Vcc

e Integrated current sense amplifier (CSA) inside 6ED2742S01Q with selectable gain

¢ Integrated over-current protection inside 6ED2742S01Q with selectable Vger threshold

e Integrated shoot-through protection with built-in dead time

e Multi-function RFE pin (Enable, Fault, and automatic Fault clear) to enable / disable motor drive
e Integrated short pulse / noise rejection input filter

User Guide 7 Revision 1.00
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1.4 Board parameters and technical data
The key specifications of EVAL-6ED2742S01QM1 are listed in Table 2.

Table 2 Specifications of EVAL-6ED2742S01QM1

. Value Unit
Parameter Symbol | Conditions -
Min. | Nom. | Max.
Input
Input voltage Vin DC voltage 10 24 48 |V
Input current Iin Input current - - 12 |A
Output
Output current lout RMS phase-out current - - 10 |A
Additional heat dissipation is
Output power Pour needed (e.g. heat sink , forced air 150 | 250 | 500 |W
cooling)
Overcurrent protection locp Peak phase-out current - - 11 |A
Switching frequency
Inverter carrier frequency ‘ Fsw ‘ ‘ - ‘ 23 ’ - ’ kHz
Auxiliary power supply
Fan power supply - 12 - v
Controller power supply - 3.3 - v
System environment
Ambient temperature ‘ ‘ With adequate cooling method ‘ - ‘ 25 ‘ - °C
PCB characteristics
L Length - 120 - mm
Dimensions W Width - 60 - mm
H Height - 25 - mm
Layer - 4 -
PCB thickness - 1.6 - mm
Copper thickness - 4 - oz.
Material FR-4, RoHS-compliant

Note: The evauation board is designed to evaluate the parameters of 6ED2742501Q three phase gate driver IC.
The board does not have over temperature protection and care should be taken to set the correct OCP - over
current protection level with ITRIP config setting before starting the board test with a given BLDC motor.The
board is design limits with and without heatsink are as below:

Table 3 EVAL-6ED2742501QM1 board thermal [ overcurrent limits:

With With air | Typical Board Phase current
heatsink | cooling | Speed temperature after
15 minutes
No No 52 kRPM 80°C 8 Arms, 16 Apeak
Yes No 58 kRPM 75°C 10 Arms, 20 Apeak
No Yes 60 kRPM 75°C 11 Armns, 21 Apeak
Yes Yes 62 kRPM 82°C 12 Arms, 22 Apeak
User Guide 8 Revision 1.00
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2 System and functional description

2.1 Getting started with EVAL-6ED2742S01QM1

To run the motor system, a combination of the power board EVAL-6ED2742S01QM1 and a matching iMOTION™
control board (e.g., EVAL-M1-101T) are required. This chapter explains how to set up the system and get started
with the IMOTION™ development platform.

The power board EVAL-6ED2742S01QM1 can run a BLDC motor by connecting to the iMOTION™2.0 control board
EVAL-M1-101T through an M1 interface. The system connection is shown in Figure 3, and the test results are listed
in Section 4.1.

MADK Board 6ED2742S01Q Eval Board

2021-09-02

Ne o [I23 X331 - i
A U»f ] EVAL-6ED2742S01QM1 _VER], 2 I®Nca
L}

¢
s

To 3 phase
BLDC Motor

R 4RIBIT | T
CiSp1oleM 20 15

o . T n Y il | DC Input:
e TN, L Po ¥ 3k ‘ ;
SEERIEORCC0000O0, : : 12V t0 48 V

Figure 3 The system connection for running a BLDC motor.

2.1.1 The iMOTION™ control board

The latest IMC101T-T038 MCE software package can be downloaded from www.infineon.com/imotion-software.

With EVAL-M1-101T and the latest software, connect your PC to the control board via a USB cable to program and

tuneit.

1. Connect EVAL-M1-101T’s M1 20-pin interface connector J2 to the EVAL-6ED2742S01QM1 board connector
J3.

2. In the MCEWizard, enter the system and operating parameters of the target motor and the hardware
parameters of the evaluation board. This data is used for calculating the digital parameter set of the
controller, representing the complete motor drive system.

User Guide 9 Revision 1.00
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3. Go to the Verify & Save page and click Calculate Parameters. Then, save the drive parameter set into your
project directory by clicking Export to MCEDesigner file (.txt) (see Figure 6). This saved drive system
parameter file will be used later by the MCEDesigner. Refer to Section 2.1.4 or the MCEWizard user guide for
more information.

4. Connect motor phase outputs (J2 on the EVAL-6ED2742S01QM1 board) to the motor.

5. ConnectDCinputto the powerinput connector (J1 onthe EVAL-6ED2742S01QM1 board), then power on the
system. Note the

6. Startthe MCEDesigner tool.

Click File > Open to open the MCEDesigner default configuration file (.irc) for the IMC101T-T038 controller
(IMC101T_Vxxx.irc). The IMC101T_Vxxx.irc file is included in the IMC101T-T038 MCE software package.

8. The MCEDesigner should automatically connect to the EVAL-M1-101T control board using the default COM
port (indicated by a green circle next to the “COMx Up” status in the bottom frame of the MCEDesigner GUI).
If the connection cannot be established, change the COM port as follows:

a) Open the System Page window.
b) Click Preferences > Connection > Connect using.
c) Choose one of the other available COM ports from the drop-down list.
Program the system parameters into the internal SRAM of the IMOTION™ IC using the following steps:
a. Click Tools > Programmer and select Program Parameters.
b. Browse and select the System Drive Parameters file created in step 3. See Section 2.1.4 for more
information.
10. Start the motor by clicking the green traffic light button in the control bar. To stop the motor, click the red
traffic light button in the control bar.

©

2.1.2 iMOTION™ development tools and software

The EVAL-6ED2742S01QM1 evaluation board can run a BLDC motor when connected to an external control board
EVAL-M1-101T. Users must configure the iMOTION™ development tool and software according to the system and
BLDC motor parameters.

The MCEDesigner and MCEWizard are based on MCEDesigner v2.3.1 and MCEWizard v2.3.1 and can be
downloaded together with supported files from http://www.infineon.com/imotion-software.

A review of references [10] to [16], on page 45 will provide a deeper understanding of the overall iMotion™
ecosystem.

2.1.3 MCEWizard setup overview

Use the MCEWizard to configure the parameters for the evaluation board or motor. Figure 4 shows the Welcome
page of the MCEWizard. Here, users can select the control board or power board from a drop-down list. Infineon
releases new control and power boards regularly. Therefore, it is possible that some of the latest power boards
have not been pre-configured in the MCEWizard tool and cannot be selected from the drop-down menu. In that
case, users can select another power board (as similar as possible) and follow the setup steps in the MCEWizard
by entering parameters specific to the power board chosen. Please refer to the application note of the
corresponding power board for additional information.

After selecting the modular application design kit (MADK) control board and the power board, click Next in the
right-hand bottom corner of the Welcome page to start the MCEWizard system setup process.

User Guide 10 Revision 1.00
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Q MCEWizard 2.3.0.1 - C/Users/wchu1/WDC/IPC/ISD/IPM/imotion/iMotion 2/SiC board/Golden age motor.mc2 = X

File JumptoPage Help

Welcome Page -

iMOTION™ 2.0 System Configuration Wizard

Using System Configuration File:

EVAL-M1-101T-05-65D.mc2 Infmeon

P

This motor control system is an
evaluation kit for complete inverter-
controlled motor drive applications
based on EVAL-M1-101T iMOTION
MADK controler board (based on
IMC101T-T038 iMOTION controller)
and EVAL-M1-05-65D MADK inverter
board (based on IRSM505-065DA2
CIPOS Micro IPM).

Following two options are available. ~ —
If no hardware change is done on this
board and there is no plan to change
default control settings:

Select > Default Hardware and Control

Settings. Get MADK Hardware Info Get iIMOTION™ Info
Open System Configuration File I
Save System Configuration File |
Previous Next

Figure4  Welcome page of the MCEWizard

The iIMOTION™ system enables users to easily test different combinations of control and power boards with their
motors. Users should be familiar with system-level parameters related to the motor used. There are a limited
number of parameters specific to the control board or power board hardware. Table 3 lists the hardware
parameters specific to the EVAL-6ED2742S01QM1 power board for MCEWizard setup. Similar tables are available
for each control board in its application note. A combination of data in this table and the corresponding table of
the control board provides sufficient information to set up the motor drive system quickly.

Table 4 MCEWizard setup overview table

Parameter Value

Control board selecting EVAL-M1-101T for example

Motor 1 shunt configuration Single shunt

Controller supply voltage +3.3V

Max DC bus voltage 36V

DC bus sensing high resistor 300 kQ

DC bus sensing low resistor 4.7kQ

NTC temperature shutdown value Refer to the control board’s application note [6]

Gate sense low-side devices High is true

Gate sense high-side devices High is true

Motor 1 current input scaling Calculated in the corresponding section of the
control board’s application note [6]

After all the MCEWizard questions are answered, the Verify & Save page opens (see Figure 5.)
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n MCEWizard 2.3.0.1 - C\O1-Workspace\02-2ED1324 + IGETY module - Jinsheng Eva\03-Firmware\Firmware debugiHig... - x
File JumptoPage Help
|‘|.'erify & Save Page - |
Verify Parameters
|Calculate Parameters| |Displa'y Parameters Rﬂsults| |E)qmrl to MCEDesigner File (.b:t)|

Double-Click an item to JUMP to its associated question

Figure5 Verify & Save page of the MCEWizard.

Click Calculate Parameters and then Export to MCEDesigner File (.txt) to save the parameter file. This file will

be used by the MCEDesigner in the next steps.
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2.1.4 MCEDesigner setup overview

The MCEDesigner is a user interface to access or debug the control board. Open the MCEDesigner and then open
the IMC101T_xx.irc file. The main display page for EVAL-M1-101T opens, as shown in Figure 6.

jg Systern - EVAL-2ED1324512PM1_HighPower.irc - MCEDesigner Ver 2. 3. 0. 1 - Infineon Technologies — O x

File View Preferences Tools Window Help
EERE o
¥ | System - EVAL-2ED1324512PM1_HighPower.irc =m|wEe| 3
W C\O1-Workspace\0 ~
= Monitor Definiti
#— B FluxrAngle &
# @ MotorSpeed
w— B lu & Iv_Fast
#— B Ju & v_Slow
w0 lu & Flx_M
B Flx_Q & Flx _t
#— B u & MotorS
o @ lu & Trg v
< >

[ = 52

|
@)

B CAD1-Workspace\0 A~
=—{& User Applicatior

=M Start Motor
=8 Stop Motor
# M Drive Status
M Emergency £
=8 Configure M
B Reference Sg
B //=======
=@ Clear Faults
# @ VYF Diagnost

# B Read DC Vol

b B Cuiernnt L

< >

For Help, press F1 IMC101T COMS Down |[Trig Idle | ® Motor1 Ini * Systemn Inactive

Figure6 MCEDesigner’s main display for EVAL-M1-101T

After the drive system parameter file has been programmed into the IMC101 controller, and the motor drive
system powered, the MCEDesigner can be used to start/stop the motor, display motor current traces, change the
motor speed, modify drive parameters, and perform many other functions. Please refer to the MCEDesigner
documentation [8] for more details.

2.2 M1 Connector Pin details

In case the user prefers to use custom microcontroller, the pinout details of the 20 pin M1 connector used on the
EVAL-6ED2742S01QM1 EVAL board is as shown in Table 5. The PWM signal output from the custom
microcontroller can be fed to Pin 1,2, 5,7,9,11 and the single shunt current feedback is available on Pin 10 and
Pin 12. Over current protection / RFE output from the 6ED2742S01Q is available on Pin 13. VCC of 3.3V (Pin 6, 8)
and GND (Pin 2, 4) is also available.

User caninterface their microcontroller signals as per the pinout shown in Table 5 and evaluate with their existing
code of different control schemes such as trapezoidal / block commutation and Sensorless Field Oriented
Control (FOC).

User can also look at EVAL-M1-101TF control card (available to order separately), that comes with Hall Sensor
Inputs to evaluate their existing code of Hall Sensor based FOC control.
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Table 5 20-pin M1 connector setup

Pin | Name Pin Name Connectors

1 PWMUH VDD compatible logic output for high side gate driver-Phase U
2 GND Ground

3 PWMUL VDD compatible logic output for low side gate driver-Phase U
4 GND Ground

5 PWMVH VDD compatible logic output for high side gate driver-Phase V
6 +3.3V On board VDD supply

7 PWMVL VDD compatible logic output for low side gate driver-Phase V
8 +3.3V On board VDD supply

9 PWMWH VDD compatible logic output for high side gate driver-Phase W

10 U+ Shunt voltage phase U

11 PWMWL VDD compatible logic output for low side gate driver-Phase W
12 IU- Ground

13 GK Gate kill signal - active low when over current is detected

14 DCBSENSE | DC bus positive voltage, scaled in 0 - VDD range by a voltage divider

15 VTH Thermistor input
16 IV+ Shunt voltage phase V
17 IV- Ground
18 IW+ Shunt voltage phase W
19 IW- Ground
20 VCC Defined for 15V Power Supply (not used in this board)
User Guide 14 Revision 1.00
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2.3 Description of functional blocks

The motor inverter in EVAL-6ED2742S01QM1 hardware design is implemented by the new 160 V SOI three phase
gate drivers 6ED2742S01Q and six OptiMOS™ 150 V N-Channel MOSFETs - BSCO74N15NS5. The auxiliary power
supply is derived from a high voltage DC-DC buck converter providing 12 V followed by a LDO providing the 3.3V
required to power the iMotion™ IMC101T microcontroller.

2.3.1 Overview of 6ED2742S01Q

Figure 7 shows the functional block diagram of 6ED2742S01Q. For more information such as static and dynamic
electrical characteristics of the gate driver, please refer to the datasheet of 6ED2742501Q.
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Figure 7 Functional block diagram of 6ED2742S01Q
User Guide 15 Revision 1.00

2023-06-01



EVAL-6ED2742S01Q for Battery Powered Applications Evaluation Kit

User Guide

System and functional description

The main features of 6ED2742501Q include:

Bootstrap voltage (VB node) of +160 V

Floating channel designed for bootstrap operation

Integrated power management unit (PMU) with

o Linear pre-regulator to enable wide input VIN range

o Integrated charge pump for stable Vcc

Integrated current sense amplifier (CSA) with selectable gain
Integrated over-current protection with selectable Ve threshold

100% duty cycle operation with trickle charge pump per high side

Integrated low Roy, ultra-fast bootstrap diodes

(infineon

¢ Independent under voltage lockout for both high and low side
e Integrated shoot-through protection with built-in dead time
e Multi-function RFE pin (Enable, Fault, and automatic Fault clear)
e Integrated short pulse / noise rejection input filter
e Schmitt trigger inputs with hysteresis
e 3.3V,5Vinputlogic compatible, outputs in phase with inputs
e Available in small footprint QFN32 lead, 5x5 mm package
e 2kVHBM ESD, RoHS compliantin a 5 x5 mm VQFN-32 package
Table 6 Absolute maximum ratings of 6ED2742S01Q
Symbol Definition Min. Max. Units
Vs High-side floating well supply voltage (Note 1) -0.3 160
Vin Input battery supply voltage 5 140
Vs High-side floating well supply return voltage -0.3 140
Vas Bootstrap supply range -0.3 20
Vo Floating gate drive output voltage Vs-0.3 Vg+0.3
Vres Charge pump input voltage -0.3 20
Vee Low side supply voltage -0.3 20
Vio Low-side output voltage -0.3 Vec+0.3
Viocic v Logic input voltage (HIN, LIN) -0.3 5
BJTDR Output signal for base drive of external NPN BJT -0.3 20 y
RFE Enable, Fault and automatic fault clear pin -0.3 5
ITRIP Over current protection input pin -0.3 5
ITRIP CONF | Over current protection threshold configuration pin -0.3 5
CSO Current sense op amp output -0.3 3.6
CSO GAIN | Current sense op amp gain configuration pin -0.3 5
STR Strobe signal for op amp offset compensation -0.3 5
CP1 Charge pump capacitor pinl -0.3 20
CP2 Charge pump capacitor pin2 -0.3 20
COM Low side power ground return -5.0 +5.0
dVs/dt Allowable Vs offset supply transient relative to COM — 50 V/ns
Package power
Po dissipftiopn @ Ta<+25°C >x5mm QFN-32 3 W
Rth,, | nermalresistance, g o oFN-32 41 °C/W
junction to ambient
T, Junction temperature — 150 °C

Note 1: There is an additional power dissipation in the internal bootstrap diode between pins VCC and VB for activated bootstrap diode in
caseVCC>VB
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The 6ED2742S01Q internal Power Management Unit (PMU) can be configured to operate in four configurations.
EVAL-6ED2742S501QM1 is desgined to work in config #2 by default and can be configured to work in config #3 by
removing R24 resistor on PCB board. Furtherinformation on operating the 6ED2742501Q in config #1 and config
#4 mode can be found in the device datasheet.

2.3.2 6ED2742S01Q PMU in Config #2 - Pre-regulator / charge pump: Vgarr connected to VIN

Configuration #2 provides wider input voltage flexibility with the smallest form factor since an external BJT is
not used. Typical input voltage range operation up to 96 V is possible.

Current Flow Direction
E—
VIN BJT_DR
— > R —
N LINEAR Pre-REGULATOR L]
Ry LRout
Vearr
— vee Icp_ave VREG
—_— . CHARGE <
i i< PUMP L
J D1 CPout CPy
vee C
| ol
Cuee =r 3-PHASE GATE DRIVER T
1uF
—l i l L L
UHO_LO VHOfLO WHOfLO CPl CPZ
V v " Cep %

Figure 8  Typical configuration for 12V to 90 V applications

Table 7 Charge pump only operating conditions (typical)
Vearr=VIN | BJT_DR VCC
(V) =VREG (V)
(V)
90
12
60
15.5
48
12
36
24
12 10.5
9 7.5
2.3.3 6ED2742501Q PMU in Config #3: Vearr connected to VIN and external BJT

Configuration #3 provides the widest input voltage range with the addition of an external NPN BJT to share the
power dissipation between the internal PMU blocks and BJT.
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——  Current Flow Direction

VIN
_—
— LINEAR Pre-REGULATOR
Ry
——— vee Iep_ave
VBATT
» < CHARGE PUMP
{ D1 CPour
vce
L
—
Cuee r 3-PHASE GATE DRIVER
—l i l L L

Uno_io Vio_to Wio_to CP1 CcP2

Figure 9  Typical configuration for VIN > 60 V,c applications. For stability reasons VREG capacitor needs
to be 10 uF in this configuration

Table 8 Pre-regulator, Charge pump, external BJT operating conditions (typ - 25°C)

VIN (V) BJT_DR (V) VREG (V) vce (V)
120
90
80 15.5
16.5
36 12
24
18 14.5
12 10.5 9.5
8 6.7 5.7 10

Typical input voltage range recommended is up to 120 V. lcp_avc 0f 15 mA for VIN operating range of 10 V- 120 V.

2.4 Shoot-through protection

The 6ED2742S01Q is equipped with shoot-through protection circuitry (also known as cross-conduction

prevention circuitry). Figure 10 shows how this protection circuitry prevents both the high- and low-side
switches from conducting at the same time.
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Figure 10 Illustration of shoot-through protection circuitry

2.5 Enable, Fault reporting and programmable fault clear timer

The 6ED2742S01Q provides an enable functionality that allows it to shutdown or enable the HVIC and also
provides an integrated fault reporting output along with an adjustable fault clear timer. There are two situations
that would cause the IC to report a fault via the RFE pin. The first is an undervoltage condition of VCC and the
second is if the over-current feature has recognized a fault. Once the fault condition occurs, the RFE pin is
internally pulled to VSS and the fault clear timer is activated. The RFE output stays in the low state until the fault
condition has been removed and the fault clear timer expires; once the fault clear timer expires, the voltage on
the RFE pin will return to its external pull-up voltage.

The length of the fault clear time period (trrcir) is determined by exponential charging characteristics of the
capacitor where the time constant is set by Rrre and Cree. Figure 15 shows that Rgee is connected between the
external supply (Vop) and the RFE pin, while Cye is placed between the RFE and VSS pins.

uc

O

DC-BUS R

Figure 11 Programming the fault clear timer

The design guidelines for this network are shown in Table 7
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Table 9 Fault clear timer design guidelines
<1lnF
CRFE .
Ceramic
0.5MQto2MQ
RRFE
>> Ron, rein

The length of the fault clear time period can be determined by using the formula below.
Ve(t) = Ve (1-e7C)

trireir = -(RreerCree) 1N (1-Vree/Vop ) + 100NS

The voltage on the RFE pin should not exceed the VDD of the uC power supply.

The EVAL-6ED2742501QM1 board has Cgre of 1 nF and Rgre of 1 MQ.

2.6 Over-current protection

The 6ED2742S01Q is equipped with an over-current feature in addition to the stand-alone Current Sense
Amplifier (CSA). This functionality can sense over-current events in the DC- bus. Once the IC detects an over-
current event, the outputs are shutdown, and RFE is pulled to VSS.

The level of current at which the over-current protection (OCP) is initiated is determined by the shunt resistor
connected between COM pin and VSS pin as shown in Figure 12, and by the threshold configured by ITRIP CONF
pin (Virrie:). The circuit designer will need to determine the maximum allowable level of current in the DC- bus
and select Ro and Virrip--

Virrip+= Ro X Ipc.

DC BUS +
—{VIN
VB —
— HIN ==
—*LIN
HO
<«— RFE
VS
VSS
Q3
I ITRIP LO
C1
R1
COoM
DC BUS -
RO Inc.

Figure12 Programming the over-current protection

For example, a typical value for resistor Ry could be 10 mQ as with EVAL-6ED2742S01QM1 board providing the
over-current protection on the ITRIP as 25 A with a ITRIP config threshold set to 0.25 V. See figure 14 to enable
the correct switch position for this configuration on board.
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KFEE LUl fF—
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: 3 1
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ITEP lﬂc 27 3 -t ﬁ—E f'

T | ITRIP_CONE LO3 e

T 21 cso_oam com -2

- = CS0_GAD COM
1k [ ELI

X4 j €0
BT k2
| TR @cm

Cs0

4 [
5GHD K S5
+3.3V
T
51 X3 2
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Figure 14 Over current protection ITRIP-Config section of EVAL-6ED2742S01QM1 board. Slide switch
on position 2 to set 0.25 V ITRIP threshold.
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2.7 Integrated Current Sense Operational amplifier - unused in current EVAL-6ED2742S01QM1
board

A current sense operational amplifier (CSA) with configurable gain is integrated in the gate driver sensing the
voltage between VSS and COM pins. The amplifier has a strobe input signal. When strobe signal is LOW the
operational amplifier output signal CSO is following the VSS-COM voltage multiplied by a certain gain, when
strobe signal is HIGH CSO signal is reporting the op amp offset. CSO output has an offset added above VSS of 150
mV. This offset ensures the measured current remains positive and does not go negative in any regular operating
conditions.

coMm
- Zero level shift

; &
Rshunt © variable gain
]

VSS =

STR

CsoO

Figure 15 Current sense operational amplifier

- I/I/I I/I/I #

Real Zero Shift available on CSO for

150 mv -
ADC calibration

STR=0 STR=1

STR »

Figure 16 Current sense operational amplifier timing diagram

This section is not enabled in the EVAL-6ED2742S01QM1 board. Pages 42 and 43 in the current document show
the simulated performance of the above integrated current sense amplifier.

User can tap the CSO output at test pin X14 on the EVAL-6ED2742S510Q board to verify the linearity and slew
rate of the amplifier. A new EVAL-6ED2742S01QM1 Multifold Control board will demonstrate the performance of
this amplifer along with XMC1302 microcontroller based MADK control card.
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2.8 Gain settings for the over current protection (ITRIP_Conf) and current sense operational
amplifier (CSO)

The gain for the over current protection via ITRIP and current sense operation amplifier output can be set using
a simple potential divider network as shown in below figure 17.

VBATT +

,,,,,,,,,,,, o +

BJT DR VIN

vee _>|_ VB1,23
J_ _L L |cp -
T cr2 |
I I VREG HO1.23 \t;
s3v [ ™| HNL23
—» LIN123
<4—»| RFE Vs123
—» TRIP
ITRIP CONF t;
CSO GAIN L0123
-4—— CSO
—»| STR
vss com

I

V BATT -

Figure 17 Setting over current protection (ITRIP) gain and current sense operational amplifier gain
via the resistor divider

The voltage of the potential divider network can be scaled down from an external 3.3 V. It should be noted that
when powering from external 3.3 V the supply sequencing should be such that the 6ED2742 is first powered up
via VIN before applying the 3.3V to the Gain / Config pins. Two use cases are shown in figure 20. Figure “a” shows
the option where the 3.3 Vinput is either ramped up after or along with VIN / VCC. RFE gets asserted (IC gets
enabled) after the UVLO of VCC is crossed and Vgee: threshold is crossed. Figure” b” shows use case when the 3.3
V input is already available before VIN / VCC arrive. In this case, RFE gets asserted when the UVLO of VCC is
crossed. Itis good to note that the RFE pin is held low under two conditions:

Under Voltage Lock Out (UVLO) of VCC / Vgee
ITRIP threshold as set by ITRIP Config is crossed

In case the 3.3 V arrives before VCC toggling (pulling down and the pulling up) the RFE will re-read the values of
ITRIP config and CSO Gain.
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3.3V
8Vio 120V ITRIP Conf:
33 CSO Gain 3.3V
0V VIN
1V 8Vio 120V
VIN
ov vee ov
12V
33V 33V
ITRIP Conf vcec
CS0 Gain /7 ov
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w33V
33V
ov RFE
ov RFE
ITRIP H
ov ITRIP 0
Figa Figb

Figure 18 Input voltage sequencing for setting up different gain and ITRIP config

The voltage limits for different gains are as shown in the electrical characterisitics table 3 in page 6 and 7. They
are summarized as beow in Table 8 and 9

Table 10 ITRIP Config pin voltage settings for different overcurrent threshold voltages
950 | 1000 | 1050 ITRIP Conf>3V
475 500 525 1.5V<ITRIP Conf <2V
Over current threshold
Vitrie mV
voltage
225 250 275 0.5V<ITRIP Conf<1V
110 130 150 ITRIP Conf <0.25V
Table 11 CSO gain pin voltage settings for different gain of CSO output
36 40 41 CSO gain>3V
18 20 21 1.5V <CSO gain<2V
Current sense
Geso amplifier gain .
9 10 11 | V/V| 0.5V<CSOgain<1V
4 5 6 CSO gain <0.25V
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Figure 19 EVAL-6ED2742S01QM1 provides switch configurations to test different gain and threshold
levels

2.9 Advanced input filter

The advanced input filter allows an improvement in the input/output pulse symmetry of the HVIC and helps to
reject noise spikes and short pulses. This input filter has been applied to the HIN and LIN inputs.

Figure 19 shows a typical input filter and the asymmetry of the input and output. The upper pair of waveforms
(Example 1) show an input signal with a duration much longer then tq.; the resulting output is approximately
the difference between the input signal and ten. The lower pair of waveforms (Example 2) show an input signal
with a duration slightly longer then tqn; the resulting output is approximately the difference between the input
signal and trun.

Figure 22 shows the advanced input filter and the symmetry between the input and output. The upper pair of
waveforms (Example 1) show an input signal with a duration much longer then tqn; the resulting output is
approximately the same duration as the input signal. The lower pair of waveforms (Example 2) show an input
signal with a duration slightly longer then ten; the resulting output is approximately the same duration as the
input signal.
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Figure 19 Typicalinput filter Figure 20 Advanced input filter

2.10 Short-Pulse / Noise rejection filters

This device’s input filter provides protection against short pulses (e.g., noise) on the input lines. If the duration
of the input signal is less than tqw, the output will not change states. Example 1 of Figure 21 shows the input
and output in the low state with positive noise spikes of durations less than tqn; the output does not change
states. Example 2 of Figure 21 shows the input and output in the high state with negative noise spikes of
durations less than tqin; the output does not change states.

IN t
— FILIN
S Jlan 1]
S
IS
S ouT
L
IN
g |_|tFIL,IN u |_|
a
IS
g out
L

Figure 21 Noise Rejecting Input Filters

2.10.10verview of BSCO74N15NS5

The BSCO7T4N15NS5 is a 150 V rated N-Channel OptiMOS™ 5 power MOSFET. It was mainly chosen for its 5 x 6
Super SO8 package and its excellent gate charge x Ros on) product Figure of Merit (FOM).

Figure 22 shows the key features of BSCO74N15NS5. For more information about the MOSFET, please refer to the
datasheet of BSCO74N15NS5.

Parameter Value Unit

S1
[ 18D [y 150 Vv

Sz [] =] 7D | Ros(on)max 7.4 mQ
S3 E —j 6D .’D 1 14 A

Qoss 116 nC
G4 [ L[] 5D

Qu 23 nC

Figure 22 Key features of BSCO74N15NS5
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The typical gate charge characteristics and typical capacitances of BSCO74N15NS5 are shown in Figure 23.
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Qgate [nC] Vos [V]
Vis=f(Quate), 15=50 A pulsed, T;=25 °C; parameter: Vpp C=f(Vbs); Ves=0V; f=1 MHz

Figure 23 BSC074N15NS5 typical characteristics

Areview of references [8] and [9], on page 45 will provide a deeper understanding of the features of OptiMOS™ 5
technology and its benefits in low voltage high power motor drive applications.
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3 System design

This chapter covers the hardware design of EVAL-6ED2742S01QM1 in detail. Users can modify the circuit or re-
select the component values based on DC bus voltage, motor type.

3.1.1 DC-link voltage measurement and inrush current limiter

Bus capacitors should be large enough to stabilize the bus voltage.
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c
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o 11
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Figure 24 Bus capacitor configuration and DC bus sensing
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3.1.2 Inverter section using OptiMOS™ 5 BSC074N15NS5

The inverter section is implemented using BSC074N15NS5 as shown in Figure 25. It is a three-phase inverter

bridge section with Infineon’s OptiMOS™ 5 N-channel MOSFETs. R40/ R41 (in parallel) are single shunt for current
sensing.
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Figure 25 The diagram of the BSC074N15NS5 based inverter section with single shunt current sense
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3.1.3 Drive circuit with 6ED2742501Q
The configuration of 6ED2742S01Q is shown in Figure 26.

The capacitor C33 (C34, C35) is used as bootstrap capacitor to provide the necessary floating supply voltage VBS.
Thanks to the bootstrap diode integration in 6ED2742501Q, an external bootstrap diode is not needed.

6ED2742501Q is equipped with ITRIP input pin. This functionality can be used to detect overcurrent events in the
DC bus. When the gate driver IC detects an overcurrent event through the ITRIP pin for one of the three phases,
the output is shut down and the RFE is pulled to VSS to report the fault condition. The outputs of the other two

phases are also shut down because of the daisy chain connection with the RFE pins. The RFE can also be used as
the enable input pin and fault-clear time programmable pin.

The fault-clear time setup is based on the datasheet of 6ED2742S01Q. The main feature of 6ED2742S01Q
designed with Infineon’s SOI technology is its tolerance in terms of negative transient voltage in inductive load

applications. 6ED2742S01Q can tolerate repetitive negative transient voltage of up to 15V (pulse width up to 100
ns).

DC+
VCC  VREG BITDR
Nl OX3 X4

A

. 7 D8 RIS
1 INALEW- 14 10R 3 |,_} ING 148 W-1-F 10R n ‘y—} INGI4SP-T-F 10R 4 ‘)—}
RIT 2R Q{>— RIE 128 Q,l'-_ RI? 228 Q;'_—

X18 i)

HO? HO3

4

|
Tooar | I oo 7

mu:l-} 2 1]

= D10

e | — " S
& n :
N4 4EW-T-F TR |, I‘—}
P

o1 12 L1 |
. R34 22R 1
{eh] <
ot}
ot 8

pn

R30 = RB32 -
N4 14EWLTF 10R |, ‘_} 14 148 W-1.F ) R
el peld

= = = =t
R35 1R o8 R36 1R o

\I.peny
|'= PGND

Ri3
OR
Dic—xp B
|_Jj:{'és =

Figure 26 Drive circuit design with 6ED2742S01Q
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3.1.4 Overcurrent protection

The overcurrent circuit is shown in Figure 25. To save power loss of the shunt resistor, the Rwnt Value is set as 10
mQ by using two 20 mQ / 2 W surface-mounted devices (SMD) resistors (R40/R41) and low equivalent series
inductance (ESL) in parallel. In the design, the target current for overcurrent protection (loce) is 25 A. The
overcurrent threshold of the ITRIP pin is 0.54 V. An additional 0.19 V DC-bias voltage is needed at the ITRIP pin to
meet the target current of 25 A. This is achieved by using resistor dividers R19 and R20 with 3.3 V supply.

The locp is calculated using:

R19
(Virrip+ — RT9 3 170 * 3-3V) * (R19 + R20)

R20 * Rshunt
=2493 4

locp =

Here, Virrip+ is the positive-going threshold for ITRIP and its typical value is 0.44 V, R19 = 100 Q, and R20 =1 kQ.

Note: If EVAL-M1-101T is not used as the controller board, an offset circuit needs to be added.

3.1.5 Auxiliary power supply

The auxiliary power supply is derived from BM0650HV based DC-DC buck converter. The 12 V DC can be
connected an external Fan (not provided with the Eval board) for forced air cooling during prolonged testing. The
3.3V power supply required for the IMC101T based MADK control card is derived from the 12V DC using the linear
regulator IFX25001ME V33. This 3.3 V power supply is also used to bias different circuitry on board such as the
ITRIP config and CSO config. The auxiliary supply stage is as shown in the schematic in figure 27.

23150V Input (Max21V~180V)

+
[iE] -
Y NC3 Dl D2 +12V UL IFX25001 V33 £33V Y
S swavm wea (2L [ I e 2B
| Pl e |7l =l -
iz SWIVIN  NC1 ES17 ES1T = Ri
& {vss VDD - 1
_l+c1 BMO6S0HY 1 es - A c7 2
T LouF 17 T 10uF T 10uF LED3
_lce 1 <4 | 6 Green
T 1Ink D3 —T 100uF T 100uF %
zgss;:c
12V_FAN -
N7
5GHD

Figure 27 A high voltage DC-DC buck converter provides 12 V followed by a 3.3 V generated from a
linear regualtor
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3.2 Schematics

The schematics of EVAL-6ED2742S01QM1 are shown in Figure 28

8.1
R

i

10

Figure 28 Circuitry of the power inverter board (main board)
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3.3 Layout

3.3.1 Layout details

Detailed layouts of the main inverter board are shown in Figure 29 to Figure 32.
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Figure 29 Power inverter board layout (top view)
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Figure 30 Power inverter board layout (bottom view)
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Figure 31 Drive circuitry layout of the daughter board (top view)
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Figure 33 Drive circuitry layout of the daughter board (bottom view)
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Figure 34 Drive circuitry layout of the daughter board (bottom view)

Both the schematic and layout files in Altium are provided on the 6ED2742S01Q webpage online. Users can
download the same by logging in with their infineon.com credentials.

3.3.2 Layout guidelines
Some basic layout guidelines are as follows:
o TheVcc and Ves bypass capacitors should be close to the IC
o Thedrive loop should be as small as possible

e The loop of VSS and COM should be made as small as possible by connecting the VSS and COM directly
at the shunt-resistor terminals

e Thetwo current-sensing traces should be started from the shunt terminals and placed close to each other

See pages 30 and 31 of 6ED2742S01Q datasheet for further layout guidelines.
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3.4

Bill of material

The complete bill of material (BOM) is available in the Downloads section of Infineon’s homepage. A login is
required to download this material.

Table 12 lists the important components used in EVAL-6ED2742S01QM1.

Table 12 BOM with Infineon components in Bold
Designator Component Value | Description Quantity
CAP / ELCO / 10uF / 200V / 20% /
C1 10uF Aluminiumelectrolytic 1
Cc2 1nF CAP/-/1nF/25V /10% / X7R (EIA) 1
C3 4.7uF/50V Chip Monolithic Ceramic Capacitor 1
C4, C6 100nF Surface Mount Ceramic Capacitor 0.1uF 25V X7R 10% 2
C5, C7 10uF Chip Monolithic Ceramic Capacitor 2
CAP / ELCO / 220uF / 25V / 20% /
Cc8 220uF, 25V Aluminiumelectrolytic 1
c9 22nF CAP /-/22nF/ 250V / 10% / X7R (EIA) 1
C19, C20, C21 100nF Ceramic Capacitor 0.1uF 250V X7R 10% SMD 1206 3
CAP / ELCO / 150uF / 200V / 20% /
C22 150uF Aluminiumelectrolytic 1
C32 1nF Surface Mount Multilayer Ceramic Chip Capacitor 1
C33,C34,C35,C36 | 1uF CAP/-/1uF/25V/10% / X7R (EIA) 4
C37, C40 10nF CAP/-/10nF/ 25V /5% /X7R (EIA) 2
C38 10uF Chip Monolithic Ceramic Capacitor 1
D1, D2, D3 ES1) 1.0A Ultra Fast Recovery Rectifier 3
D4 BAV21W Surface Mount Fast Switching Diode 1
D5 S§S120 Surface Mount Schottky Barrier Rectifier, 20V 1
D6, D7, D8, D9,
D10, D11 1N4148W-7-F Surface Mount Fast Switching Diode 6
D12 22V Zener Diode, 5% 22V 1
IND/STD/330uH/1.1A/ 10% / 470mR / Radial /
L1 330uH Inductor, Radial; 1
WL-SMCW SMT Mono-color Chip LED Waterclear,
LED1, LED2, LED3 | Green Green, 515nm 3
Q1, Q2, Q3, Q4,
Q5, Q6 BSCO074N15NS5 OptiMOS 5 Power-Transistor, 150 V, N-channel 6
NPN Epitaxial Silicon Transistor, High Voltage
Q7 2N6517BU Transistor 1
R1 1MEG RES / STD / 1IMEG / 100mW / 1% / 100ppm/K 1
R2 DNI Standard Thick Film Chip Resistor 1
R3 1k Standard Thick Film Chip Resistor 1
R4 5.1k RES /STD / 5.1k / 100mW / 1% / 100ppm/K 1
R6, R60 51k RES /STD / 51k / 100mW / 1% / 100ppm/K 2
R7, R9, R57, R70,
R71 10k RES / STD / 10k / 100mW / 1% / 100ppm/K 5
R11, R16 150k Standard Thick Film Chip Resistor 2
R12, R20 75k Standard Thick Film Chip Resistor 2
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R13, R14, R15,
R28, R30, R32 10R Standard Thick Film Chip Resistor 6
R17, R18, R19,
R34, R35, R36 22R Standard Thick Film Chip Resistor 6
R24 OR RES/STD/OR/100mW / OR / Oppm/K 1
R33 4.7k 4.7k/150V/1% 1
R40, R41 20mR Low Value Power Metal Strip Resistor 2
R43, R44 OR Standard Thick Film Chip Resistor 2
R50 1k RES/STD/ 1k / 100mW / 1% / 100ppm/K 1
S1 ITRIP CONF Slide DIP Switch with seal tape 1
S2 CSO GAIN Slide DIP Switch with seal tape 1
Ul IFX25001 V33 Low Dropout Voltage Regulator, 3.3V Output 1
PFM Controller and 200 V Smart power with high
u2 BMO650HV avalanche capability MOSFET 1
u3 6ED2742501Q 160 V pre-regulated three phase SOI gate driver 1
3.5 Connector details
Table 13 Connectors
PIN Label Function
Various signal | X1 -X27 Test points for various onboard signals
input / output
DC+, DC- J1 DC power supply input
u/v/wW J2 Three phase-outs (U/V/W) to the motor
M1 Socket - IMOTION™ MADK-M1 20-pin interface
M1 connector J3 connector
12V Aux output |J7 12V_FAN Header
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4 System performance

4.1 System setup for running a BLDC motor
EVAL-6ED2742S501QM1 is tested while running a custom BLDC motor in the setup shown in Figure 35.
Test conditions:
e Input:Vy=24VdC
e Phase-out current: lpuase =8 Arms,
e Room temperature

e BLDC motor: Custom, lpnase= 10 A, test at speed = 52000 r/min

MADK Board 6ED2742S01Q Eval Board
uxir‘oﬂ?i g:%:g_n:;ﬁzsmom_u.z’m.z .%;n;?‘
LO3 -mmﬂu‘no R36 | Eggg;
= To 3 phase
1000 '
ek o o T | BLDC Motor
m®-~-ﬁ-ll-]1 R o ggg;’_ |
O 8 by 000 R
—liii : 20 19. o R20 N—
J1 152 ba D::lw)l J2 - Sl - -4 1 ) DC |nput
s HYG000I00000) ‘
Infineon = 12Vito48V
Q@fineon. o
Figure35 System setup for running a BLDC motor
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4.2 The output phase current

Figure 39 shows the waveform when running a BLDC motor.
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4.3 Test result for overcurrent protection

Error! Reference source not found. shows the overcurrent detection function of EVAL-6ED2742S01QM1 by ITRIP i
nput of 6ED2742501Q. Overcurrent detection shuts down the outputs of the gate driver if the ITRIP pin input is
over 440 mV and lasts longer than 500 nanoseconds. In that case, the overcurrent protection starts when the
peak current is around 24.93 A.
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Figure 40 Typical drive characteristics at switching frequency of 23kHz, parking time = 0.4s, startup
time =0.93s

For the EVAL-6ED2742S01QM1 to run for 30 minutes at the rated speed without exceeding temperatures
above 85 C (and damaging the board) a heat sink was glued with Thermal Glue onto the OptiMOS™ inverter
stage.
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5 References and appendices

5.1 Abbreviations and definitions

Table 14 Abbreviations

Abbreviation Meaning

IC Integrated circuit

MOSFET Metal Oxide Semiconductor Field Effect Transistor
DC Direct Current

BLDC Brushless Direct Current

PWM Pulse Width Modulation

EVAL Evaluation board

PCB Printed Circuit Board

SOl Silicon on Insulator
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